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Stratos-Micra  100® is a highly sophisticated ‘next generation‘ of High Sensitivity 
Aspirating Smoke Detection product that has been designed to ensure that installation 
and commissioning is as simple as possible, while optimising performance.

Stratos-Micra 100 incorporates a patented ‘artificial intelligence‘ known as ClassiFire ®, 
which allows the detector to configure itself to optimum sensitivity, alarm thresholds 
and minimum nuisance alarms for any environment.

ClassiFire intelligence also monitors the detector chamber and dust separator 
for contamination, continually adjusting the appropriate operating parameters to 
counteract the negative effects of such contamination.

The Stratos range of detectors is unique in being able to provide a consistent level 
of protection in a very wide range of environments by continuously making minor 
adjustments to sensitivity.

The Stratos range of detectors has proven its worth many times by detecting ‘difficult-
to-detect‘ slow growth electrical overload incipient fires in ‘difficult‘ environments.

This handbook gives information likely to be needed for most installations, but for 
more detailed information on subjects such as Fresh Air Referencing, please refer to the 
complete Technical Manual or System Design Guide.

This equipment is Class 111 as defined in EN60950 (i.e., this equipment is designed 
to
operate from Safety Extra Low Voltages and does not generate any hazardous 
voltages).

This label is located on the laser chamber and signifies that the unit is a Class 1 Laser 
product as specified in IEC 60825-1. The unit incorporates a Class 3B embedded laser 
which must not be removed from the detector as retinal damage may result if the laser 
beam enters the eye.

If this equipment is part of a fire detection system, it should be supplied from an 
approved power supply conforming to EN54-4.

This symbol appears on the main board of the unit and indicates that the board 
contains static sensitive components. Suitable anti-static precautions must be taken 
when handling the board.

This symbol indicates the Safety Earth stud (see section 6.2.1). This is for grounding 
cable screens and should not be connected to 0V or signal earth.

Kidde Products Ltd. has taken every care to ensure that Stratos-Micra 100 is as simple to 
install as possible but in case of difficulty, please contact our Help Line to ensure trouble 
free installation and operation. 

Kidde Products Ltd. takes no responsibility for damage or injury occasioned as a result of 
failing to install or operate the equipment in accordance with these instructions.

Introduction

HELP LINE
(+44) (0) 1844 265004

LASER CLASS 1 
PRODUCT

0832

Kidde Products Limited
       Unit 2 Blair Way Dawdon 

           City: Seaham, County Durham
                       SR7 7PP, UK

09

0832-CPD-0982

EN54-20: 2006

Aspirating smoke detectors
for fire detection and fire alarm 

systems for buildings

Class A, B and C

Technical data: see INF48029 held 
by the manufacturer
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1. Indicators

Fire indicator illuminates when the alarm level has been reached and the 

appropriate time delays have expired.

Fault. Illuminates when the unit has a fault and a fault signal is being sent 

to the fire alarm panel.

OK. Illuminates to show normal operation when there are no faults. The OK 

lamp will flash during the 15 minute Fastlearn™ period when the detector 

is first learning about its environment.

1

2

3

1
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2. Inside the 
Detector

4

3

2
2.1 Interior view

1. 	 Removable terminal blocks (see section 2.2)

2. 	 Filter (see section 10)

3. 	 Addressable bus interface card (APIC) port (see section 7.3)

4. 	 Detector address DIP switch (see section 7.1)

5. 	 RS232 serial port (see section 7.4)

5

1
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2.2 Detector 
terminal block 

connections

1.	 FAULT relay contacts (Open = FAULT) 

2.	 FIRE relay contacts (Closed = FIRE) 

3.	 APIC addressable bus connections for use in conjunction with interface card (see 

sections 6.2.2 and 7.3)

4.	 RS485 / SenseNET connections (see sections 6.2.2 and 7.2)

5.	 Power supply connections (see section 6.2.1)

2

3 4 5

1
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3 Programming 
the Detector

The Stratos-Micra 100 may be programmed from a PC when connected to the detec-

tor via a standard 9-pin serial lead connected to the serial port of the computer and 

the 9 way socket at the base of the detector (see section 7.4, ‘Connecting to a PC’). 
In order to do this, it is necessary to install the remote control software onto the com-

puter. A copy of the remote control software is contained on a disk supplied with each 

detector. Install the software in accordance with the on-screen instructions. To open 

the software, select “Start ➔ Programs ➔ AirSense ➔ Remote x” (where x is the version 

of software installed). Access the drop-down list to the right hand side of the toolbar. 

This defaults to “Detector 001”. Scroll down this list to select the detector number 

corresponding to the connected detector’s address number if the address is other then 

the factory default setting of 1 (see section 7.1).
The programmable functions are all accessed though the “Options ➔ Detector set-

tings” submenu or by clicking on the detector symbol in the remote software toolbar 

as indicated below.

The software will display a prompt for the detector’s access code (see section 3.33). 
The default access code is 0102. When the correct code is entered, the programmable 

functions may be accessed and amended as required.

The following screen appears.

This window contains all the programmable functions for the Stratos-Micra 100.

To amend one of the programmable functions, go to the relevant tab in the “Function 

settings” window, make the change and then click “OK”. This will save the change to 

the detector’s internal memory. 

A list and explanation of the various functions is given overleaf, with the functions 

grouped by the tab under which they appear.

NB: Users should be aware that using settings other than those given in section 
5.2 may alter the performance of the detector from that tested for EN54-20 or 
UL238.

 NB ☞
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3.1  Time and date – Time and Date tab

It is important that the time and date be set up correctly on the controller’s internal 

calendar/clock because it uses this information to store events in the event log. See 

section 8, “Event log” for more details. Unless specially ordered, units are supplied with 

the correct setting for UK time. This is backed up with a rechargeable battery. Later 

adjustments to the clock setting should not exceed ± 70 minutes unless a FastLearn is 

initiated

3.2  Alarm levels -  Alarm levels and delays tab, Level subgroup

The value set in the Fire, Pre-Alarm and Aux functions in the Level subgroup is 

the relatively scaled bargraph level at which the appropriate alarm is initiated on the 

detector. The Fire 2 level assigns an absolutely scaled alarm level in % obs/m.

The Aux level is set by factory default at level 10 which means that this alarm will occur 

after the Fire alarm. The default level settings for Pre-Alarm and Fire 1 are 6 and 8 

respectively. The default setting for Fire 2 is 20% obs/m.

3.3  Alarm delays -  Alarm levels and delays tab, Delay subgroup

The alarm delay is the number of seconds that an alarm level has to be continuously 

sensed before the alarm is initiated. Each alarm level has a programmable delay of 

between 0 and 90 seconds. The default delay for each alarm level is 5 seconds.

3.4  ClassiFire® override -  Alarm levels and delays tab

Note: This function is only available via the optional Input/Relay Card. This board is fitted 

in the same manner as an APIC card (see section 7.3). Only a single expansion port is avail-

able, so an APIC card cannot be fitted at the same time as an Input/Relay card.

This function is used to temporarily decrease the sensitivity of the detector by a known 

amount to prevent nuisance alarms generated by planned events, e.g., opening fur-

nace doors or incense burning during church services. 

When this function is set to a value other than zero, the shorting together of the "I/P 

3" contacts on the Input/Relay Card by means of volt free contacts will desensitise 

the detector by moving the alarm levels out by the specified percentage: e.g., if the 

ClassiFire Override level is set to 15 and the normal Fire 1 alarm is at 20%, closing the 

contacts will change the Fire 1 threshold to 35%.

NB, unlike other remote functions employing the Input/Relay card, a choice of 
input terminals is not available. This function is dedicated to the “I/P 3” termi-
nals.

3.5  Alarm factor - Alarm levels and delays tab

The detector sensitivity is set with this entry, which will also affect the probability of 

nuisance alarms. 0 = high sensitivity, higher probability, 8 = low sensitivity, lower prob-

ability. The default alarm factor is 4.

Note: The highest sensitivity setting is suitable for clean, environmentally controlled envi-

ronments, e.g. semiconductor manufacturing clean rooms where airborne pollutants are 

kept to an absolute minimum and the least contamination is cause for alarm. 

Use of this setting in a busy machine shop would lead to relatively frequent nuisance alarms 

due to the normal variation of atmospheric contamination and a lower sensitivity setting is 

recommended. It is therefore important that the alarm factor chosen is suitable for the 
area to be protected. When the appropriate alarm factor for the protected area has been 

set, nuisance alarms will be reduced to an absolute minimum.
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The following table gives suggested settings of ClassiFire alarm setting for different locations

0	 Extremely High	 Once per year	 Semiconductor manufacturing clean room
1		  Once per 5 years	 Computer room
2		  Once per 10 years	 Non-smoking office
3		  Once per 50 years	 Clean factory
4	 Medium	 Once per 1000 years	 Warehouse
5	 Medium	 Once per 5,000 years	 Warehouse with diesel trucks operating
6	 Medium	 Once per 10,000 years	 Warehouse with diesel trucks operating
7	 Low	 Once per 20,000 years	 Warehouse with diesel trucks operating
8	 Low	 Once per 100,000 years	 Warehouse with diesel trucks operating

Alarm 
Factor Sensitivity

Probability of 
Nuisance Alarm

Suggested Protected Area

3.6	 LDD Enable - Alarm levels and delays tab

When this function is ticked, Laser Dust Discrimination (LDD™) increases the response 

time of the detector slightly, whilst greatly reducing the likelihood of nuisance alarms 

due to dust ingress. LDD may be disabled in very clean rooms for a slightly faster 

response to smoke by setting this function to unticking the box. This function is ena-

bled by default. NB: Disabling LDD is not recommended for areas other than manufac-
turing clean rooms, due to the increased probability of nuisance alarms in most other 
operating environments. 

3.7	 FastLearn enable - Alarm levels and delays tab

If the detector is in FastLearn mode, unticking this box will stop the FastLearn process. 

Using the function in this way is neither recommended nor supported by Kidde 

Products Ltd. 

Ticking the box will start a FastLearn at any time. The green “OK” LED on the front of 

the detector will flash for the fifteen minutes that it takes for the FastLearn process, and 

will then change to constant illumination to indicate that the FastLearn is complete. 

Note: It will take a further 24 hours after the FastLearn for full sensitivity to be reached, 

unless Demonstration Mode has been initiated (See section 3.10, “Demo mode”). It is 

essential for proper functioning that the detector not be left in Demonstration mode, and 

that it be allowed to complete the 24-hour learning period. To cancel demo mode, tick this 

box or power down and restart the detector to initiate FastLearn mode.

3.8	 Auto FastLearn enable - Alarm levels and delays tab 

When enabled, this function will cause the detector to reset its flow thresholds and 

start a new FastLearn sequence whenever the power is cycled (turned off and then on 

again). Since the FastLearn process results in reduced sensitivity for 24 hours, there 

are times when it may be desirable to disable this function, ensuring that the detector 

retains all its settings when the power is cycled. 

It should be noted that when the function is enabled and the power is cycled, it will 

“learn” the following situations, setting them as nominal:

• Blocked or broken sampling pipes

• Blocked or missing dust separator

• Missing front cover (this will result in flow faults when the cover is fitted)

The function is enabled by default
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3.9  ClassiFire 3D - Alarm levels and delays tab
If this function is ticked, then the detector will ignore any pre-set time delays in the 

event of a rapid increase in smoke density, thereby minimising response time to 'rapid 

growth' fires. This function would normally only be used where there were long time 

delays programmed on the alarm levels. This function is disabled by default.

3.10  Demo mode - Alarm levels and delays tab
Demonstration mode is an operating mode whereby the normal 24-hour learning 

period is bypassed, so that the detector can reach high sensitivity after only the 15 

minute FastLearn period. This can be used so that initial smoke testing and other com-

missioning can be carried out. 

However, it must be understood that, since the alarm levels will be based solely 
upon the sparse data gathered during the FastLearn period, there is a risk of nui-
sance alarms due to normal variations in ambient smoke levels. For this reason, 
the detector should not be left in Demo mode for normal use when connected to 
a fire panel.  

3.11  Day start / Night start – Day/Night switching tab
These values are the times to the nearest hour at which the day/night switching is 

desired to take place on the detector. Entries are made in 24-hour format, e.g. 19 for 

7pm. Day and night switching is intended so that the detector may automatically select 

a different sensitivity when the protected area is unoccupied and fewer contaminants 

are being produced. ClassiFire automatically detects the change in smoke level after the 

protected area is left, and if the time at which this happens is within + 70 minutes of 

the programmed switchover time it selects the night-time histogram. This means that 

changes in time setting, e.g. changing to summer time, may be ignored as the detec-

tor will take this into account. The default times for day and night start are 08:00 and 

19:00 respectively

Note that if the environment actually becomes more contaminated during the 
night period for any reason then ClassiFire will adapt to that too, reducing the 
night-time sensitivity. 

3.12	 Disable Day / Night switching – Day/Night switching tab
If day/night switching is not desirable, the Disable day/night switching box 

may be ticked to leave the detector permanently in day mode.

3.13	 Remote Isolate - Alarm actions tab, Remote input subgroup
This function prevents the detector or Command Module from sending alarm notifica-

tions to the connected fire panel when the relevant activating terminals are shorted 

together via volt-free contacts. It may be used during detector maintenance or smoke 

testing.

When the function is enabled, entering a value of 01, 02 or 03 to the numeric field to 

the left of the tick-box assigns the “I/P 1”, “I/P 2” or “I/P 3” terminals of a connected 

relay/input card respectively as the activating terminals. 

Remote terminals 4 and 5 are retained for future expansion. 

When a unit is isolated, the FAULT light will be illuminated on the detector and a fault 

signal will be sent to the fire panel, Command Module or SenseNET™. 

Note: This function is only available via the optional Input/Relay Card. This board 
is fitted in the same manner as an APIC card (see section 7.3). Only a single expan-
sion port is available, so an APIC card cannot be fitted at the same time as an 
Input/Relay card.
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3.14	 Remote Reset – Alarm actions tab, Remote input subgroup
This function allows latching alarms or faults (see sections 3.17 and 3.18) to be 

remotely reset when the relevant activating terminals are shorted together by volt-free 

contacts. 

When the function is enabled, entering a value of 01, 02 or 03 to the numeric field to 

the left of the tick-box assigns the “I/P 1”, “I/P 2” or “I/P 3” terminals of a connected 

relay/input card respectively as the activating terminals. 

Remote terminals 4 and 5 are retained for future expansion.

Note: This function is only available via the optional Input/Relay Card. This board 
is fitted in the same manner as an APIC card (see section 7.3). Only a single 
expansion port is available, so an APIC card cannot be fitted at the same time as 
an Input/Relay card.

3.15	 Remote Day/Night – Alarm actions tab, Remote input 
subgroup
This function allows the detector to be manually toggled between day and night opera-

tion (see section 3.3.6) when the relevant activating terminals are shorted together. It 

is useful where the protected area is occupied at varying times, allowing the last person 

to leave the area to activate the switch. 

When the function is enabled, entering a value of 01, 02 or 03 to the numeric field to 

the left of the tick-box assigns the “I/P 1”, “I/P 2” or “I/P 3” terminals of a connected 

relay/input card respectively as the activating terminals. 

Remote terminals 4 and 5 are retained for future expansion. 

The day/night setting reverts to the previous state when the contacts are opened. The 

function can be activated by a keyswitch, latching push button or any other device that 

has volt-free short circuit contacts when activated. NB, enabling the function overrides 

any day / night switch-over times previously set (see section 3.11). 

Note: This function is only available via the optional Input/Relay Card. This board 
is fitted in the same manner as an APIC card (see section 7.3). Only a single 
expansion port is available, so an APIC card cannot be fitted at the same time as 
an Input/Relay card.

3.16	 Programmed Isolate – Alarm actions tab
When this function is ticked the detector will not generate alarms on any fire panel 

which is connected, e.g. for use during detector maintenance. The “Fault” light will be 

illuminated on the detector front panel. The isolated condition will be disabled auto-

matically after 7 days if not manually disabled. This function is disabled by default.

3.17	 Latching alarms – Alarm actions tab
When this function box is ticked it requires a reset signal to clear an alarm condition. 

Reset can be remote (see section 3.14), from the Remote Software (see section 4.1) or 

from a Command Module.

If unticked, the alarm signal is extinguished as soon as the alarm condition ends. This 

is the factory default setting.

3.18	 Latching faults – Alarm actions tab
When this function box is ticked it requires a reset signal to clear a fault condition. Reset 

can be remote (see section 3.14), from the Remote Software (see section 4.1) or from 

a Command Module.

If unticked, the fault signal is extinguished as soon as the fault condition ends. This is 

the factory default setting.
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3.19	 Cascading alarms – Alarm actions tab
Ticking this function box means that only when the detector has gone into Pre-Alarm 

does it start counting down the main Fire delay i.e. the time delays on Pre-Alarm and 

Fire 1 are cumulative. The Aux alarm is not included in the cumulative delay since it 

may be set to a higher level than either the Pre-Alarm or Fire 1 levels. This function is 

enabled by default.

3.20	 Device type – Device information tab
This function is for display purposes only. It shows any special designation for the unit, 

which will normally be Stratos-Micra.

3.21	 Firmware version – Device information tab
This function is for display purposes only. It shows the version number of the fitted 

firmware chip. 

3.22	 Run-time hours – Device information tab
This function is for display purposes only. It shows the cumulative total number of 

hours that the device has run (NB: this is not the time that has elapsed since last power-

up, but the sum total of run time since the detector memory was last reset).

3.23	 Watchdog count – Device information tab
The watchdog is a circuit built into the detector that restarts the detector in the event 

of a failure to function properly. This could be as a result of electrical spikes. This count 

shows the number of interruptions found. The details of each problem can be found 

in the event log. See section 8, “Event log” for further details.

3.24	 Device text – Device information tab
This function can be used to enter a special designation for the units, such as its work-

ing area or room number, which will be displayed on a connected Command Module 

or SenseNET™ system in place of the detector's address number, whenever the detec-

tor generates an event such as an alarm or fault. The maximum length (including 

spaces) is 16 characters. 

3.25	 Reference detector – Referencing tab
A Micra detector may use another detector as a fresh air reference. This function is the 

address of the detector which will be used as the reference.

To set a detector as a reference detector, enter its address as set by its internal DIP 

switch into this function. This function is disabled by default.

3.26	 Reference enable – Referencing tab
Ticking this box enables the reference for the detector, if one has previously been 

allocated in Reference detector (see section 3.25) This function is disabled by 

default.


3.27	 Reference level – Referencing tab
The value set with this function is the percentage reference signal subtracted from the 

detector’s signal, if a reference device has been allocated. The default value is 0.
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3.28	 Reference back-off – Referencing tab
This value is the delay time between a build up of pollution being seen by the reference 

(if used) and the pollution being seen by the detector. The default value is 15.

3.29	 Flow rate – Flow monitoring tab
This function is for display purposes only, and shows a value corresponding to the cur-

rent airflow through the detector. 

3.30	 Flow high limit – Flow monitoring tab
This value is  the level above which airflow needs to increase to trigger a fault indication 

(which may indicate a loose or damaged inlet pipe).

Flow low limit and Flow high limit parameters are automatically set up on 

initial power-up at the end of FastLearn. They can be manually adjusted after that if 

required.

3.31	 Flow low limit – Flow monitoring tab
This value is  the level below which airflow needs to be reduced to trigger a fault read-

ing (which may indicate a blocked pipe).

Flow low limit and Flow high limit parameters are automatically set up on 

initial power-up at the end of FastLearn. They can be manually adjusted after that if 

required.

3.32	 Flow fault delay – Flow monitoring tab
This feature requires the Remote Control Software version 3.2 or later, available to 

download free on www.airsensetechnology.com

The default flow fault thresholds on the Stratos-Micra 100 are set to meet the stringent 

airflow monitoring requirements of EN54-20, with a default flow fault delay of 30 sec-

onds. This may lead to unwanted flow faults being generated when local conditions 

cause short-term variations in airflow. To help alleviate such issues, the flow fault delay 

is programmable from 30 to 240 seconds. The flow level needs to be above the high 

flow threshold or below the low flow threshold throughout the delay period for a fault 

to be generated.

NB: When setting the value of this function, it is important to take into account 
that the control unit (e.g. fire panel) may not react immediately to a trouble sig-
nal being generated by the detector, and this will add to the total fault response 
time of the system.
The function value must be chosen so that the total time between the detector 
entering a fault condition and a fault signal being generated by the panel meets 
the requirements of local or national fire regulations. The maximum allowable 
response time for EN54-20 compliance is 300 seconds, and that for NFPA 72 com-
pliance is 200 seconds. 
As an example: in the latter case, if the flow fault delay were set to 180 seconds 
(within the limit), but the fire panel did not generate a fault indication for another 
25 seconds, the total response time of 205 seconds means the system would not 
comply with the regulations. 
If documented figures are unavailable for the fire panel reaction time, compliance 
with reaction time regulations may only be verified by post-installation testing.
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setting type storage interval
time per division

on chart log

0	 Detector output	 1 second	 10 seconds

1	 Detector output	 5 seconds	 50 seconds

2	 Detector output	 12 seconds	 2 minutes

3	 Detector output	 30 seconds	 5 minutes

4	 Detector output	 1 minute	 10 minutes

5	 Detector output	 2 minutes	 20 minutes

6	 Detector output	 5 minutes	 50 minutes

7	 Detector output	 10 minutes	 100 minutes

8	 Detector output	 20 minutes	 200 minutes

9	 Detector output	 50 minutes	 500 minutes

10	 flow recording	 1 second	 10 seconds

11	 flow recording	 5 seconds	 50 seconds

12	 flow recording	 12 seconds	 2 minutes

13	 flow recording	 30 seconds	 5 minutes

14	 flow recording	 1 minute	 10 minutes

15	 flow recording	 2 minutes	 20 minutes

16	 flow recording	 5 minutes	 50 minutes

17	 flow recording	 10 minutes	 100 minutes

18	 flow recording	 20 minutes	 200 minutes

19	 flow recording	 50 minutes	 500 minutes

The chart log recording rates are as follows.

In the above table the grayed section indicates flow rate recording while the white sec-

tion indicates detector and alarm level recording.

At the slowest recording rate, one month of data can be recorded. The factory default 

setting is 8.

3.33	 Access code – Miscellaneous tab
This is the access code required to amend programmable parameters. The default code 

is 0102. Once the appropriate code is entered it may be changed here to any four digit 

number to limit unauthorised access.  

3.34	 Chart recording rate – Miscellaneous tab
This function controls how frequently the detector and alarm level or flow rates are 

stored in the Stratos-Micra 100’s internal chart recorder log. (See section 4.3, ‘Chart 
recording’).
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3.35  Separator condition – Miscellaneous tab

The value given at this function is the efficiency rating of the dust separator element in 

the detector as a percentage of the efficiency of a clean separator. A new element will 

give a reading of 99 in this function. When the efficiency has decreased to 80%, the 

Fault indicator LED will illuminate and the event log will show “Separator renew”.

Note - After fitting a new element, it will be necessary to start a FastLearn to reset the 

separator condition reading (see section 3.7).

3.36  Separator change date – Miscellaneous tab

This function defaults to “--“, which means that a separator fault will only appear 

when the efficiency decreases to 80% (see 3.35, “Separator condition”). However, a 

date may be entered into this function to allow for a scheduled maintenance period. 

The detector will then generate a separator fault at the planned time regardless of the 

condition of the separator, although degradation of the separator to below 80% effi-

ciency before this date will override this. 

See section 10, “Maintenance” for further details.

3.37	 Factory default – Miscellaneous tab

Enabling this function will reset each programmable function to the default value indi-

cated in the text, where a default setting is specified. It will also put the detector into 

FastLearn mode, regardless of whether or not Auto Fastlearn is enabled (see section 

3.8). This ensures that the flow setups and alarm thresholds are optimised to the detec-

tor’s working environment after resetting. It should be noted that where a ClassiFire 

alarm factor other than the default is required for the protected area, this will need to 

be re-entered. Section 3.5 gives details of the ClassiFire alarm factors.

4. Other remote 
software features

4.1 Reset

If latching alarms (see section 3.17) or latching faults (see section 3.18) are enabled, 

the relevant alarm or fault warnings will remain on the detector front panel LEDs and 

controlling unit until a reset is performed. If using SenseNET software, individual detec-

tors can be reset (refer to the SenseNET User Guide for details). In the remote software, 

a global reset is available which resets all detectors on the SenseNET loop, or a single 

stand-alone detector.

To perform a reset, either select the menu options “Options ➔ Global Reset” or click 

the symbol indicated below.
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4.2 Histogram screen

The histogram screen shows various aspects of the detector function. To enter the his-

togram screen, either select the menu options “View ➔ Histogram viewer…” or click 

the symbol indicated below.

The following screen appears:

Smoke density 
histogram

Alarm flags

There are two types of smoke density histogram; one shown in blue (the “fast” histo-

gram) which updates every 15 minutes, feeding information to the long-term “slow” 

histograms (which appear in yellow). These set the detector sensitivity based on the 

ambient smoke conditions and it takes 24 hours for the two slow histograms (the 

“day” and the “night” histograms) to complete their learning phase (see section 3.7). 
Detector sensitivity is based on the fast histogram during FastLearn and is thereafter 

based on the currently active slow histogram. However, although the positions of the 

alarm flags are based on the slow histogram, sudden changes in smoke density are 

picked up by the fast histogram so that early warning is given.
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Sensitivity: The current absolute sensitivity of the detector in percentage obscura-

tion per metre (% obs/m)

Mean: The current mean value of smoke density, taken from the currently “active” 

histogram and given as a percentage of full scale deflection.

Variance: The “spread” of data in the currently “active” histogram and given as a 

percentage of full scale deflection. 

FastLearn: If the detector is currently in FastLearn mode, this will show the number 

of minutes remaining in the FastLearn period. When this period has elapsed it will read 

“OFF”.

Alarm factor: This is the ClassiFire alarm factor (see section 3.5, “Alarm factor”)

Day/night: This indicates the currently active slow histogram 

Alarm levels: These figures give the position of the various alarm flags in terms of a 

percentage of full scale deflection.

Detector output: This shows the real-time variation in background smoke levels in 

terms of a percentage of full scale deflection.

4.3 Chart recording

The chart recording function shows how smoke density in the protected area has var-

ied over time. The chart may be downloaded to disk or printed out from a connected 

printer.

To access the chart log, select the menu options “View ➔ Chart recording…” or click 

the symbol indicated below.



Page 18

Stratos-Micra 100 • INSTALLER’S HANDBOOK • Iss. 12

The red trace is the current alarm level and the black trace is the detector output. By 

moving the cursor along the chart, the “Chart information” window (shown at the 

bottom left) updates to show the date and time, detector level and alarm level of the 

relevant period. The ‘File’ menu option in the chart recording window allows the chart 

recording to be saved to disk or printed to a connected printer, and allows a previously 

saved chart recording to be loaded. Chart recording files have the extension “.rcw”.

Where a custom set of programmable function settings is commonly used, these may 

conveniently be saved to or loaded from disk. To open a detector function settings 

(.dfs) file, select the menu options “File ➔ Open” or click on the symbol indicated 

below.

4.4 Load / save function settings

The following screen appears:
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Click on the “List files of type” drop-down box and select “Detector settings (*.dfs)” 

as indicated below.

A list will appear of all detector settings files stored on the current drive. As a special 

case, if desiring to recall the factory default settings, there is a file named ‘default.

dfs’ in the ‘remote2k’ directory. Loading this file will reset the detector to the factory 

default.
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5. Design 
Limitations

Stratos-Micra 100 is intended to provide LOCALISED incipient fire detection only. 

This means that it is suitable for the substantial range of applications typified by; 

small non-compartmentalised rooms, warehouse racking, or pieces of electronic or 

electromechanical equipment where it is desirable to achieve individual incipient 

fire reporting. In compartmentalised rooms, each compartment would normally use 

individual Stratos-Micra 100  or Stratos-Micra 25 detectors.

This product employs a very low-power aspirator and the aspirating capability of the 

Stratos-Micra 100 detector is limited accordingly. Stratos-Micra 100 is NOT intended 

to protect large areas, or to sample from areas where there may be any difference 

in airflow rates or pressure differentials. Application of Stratos-Micra 100 in these 

circumstances is not recommended. If detection in environments conforming to these 

descriptions is required, alternative versions of Stratos products should be used.

Maximum length of sampling pipe used with the Stratos-Micra 100 detector is 100 

metres in STILL AIR with 25 sampling holes (or Capillary Remote Sampling Points). This 

will provide a transport time from the end of the sampling pipe within 120 seconds. If 

the protected area has airflow present, the maximum permitted sampling pipe length 

will be reduced. In areas or applications where the airflow rate exceeds 1 metre per 

second, maximum sampling pipe length is reduced to 40 metres.

In order for the installation to conform to EN5420, pipes must conform at least to 

EN61386-1 Class 1131.

Stratos-Micra 100 is available with an optional ‘Piped Exhaust’ type Docking Station 

(see illustration ‘A’ overleaf). This is primarily intended to allow the detector to sample 

from areas which may be at different air pressure to the detector location. Typical uses 

are for air-duct sampling and allowing the installation of the detector in under-floor or 

ceiling voids or when sampling from pieces of computer related equipment.

IMPORTANT

!
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Above ceiling sampling 
with detector mounted 

in ceiling void

Note: The piped 
exhaust docking 

station needs to be 
used in this case.

(A.) Above ceiling 
sampling with exposed 

detector

False ceiling

Exhaust pipe

Stratos-Micra 100

Sampling hole

Sampling pipe

Sampling hole

False ceiling

Stratos-Micra 100

Sampling pipe
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5.1 System Design Simple designs with short sampling pipes produce the best results. Complex sampling 

pipe runs should be avoided with the Stratos-Micra 100 detector. The use of ‘T’ 

branch-pipes is not recommended. The Stratos-Micra 100 detector is fitted with two 

sampling pipe inlets as standard. It is always preferable to use two shorter pipes as 

opposed to one longer pipe. If two sampling pipes are used, care should be taken to 

keep the sampling pipe lengths and number of sampling holes on each pipe within 

10% of the other. This can be verified using the PipeCAD system design software. 

Unused sampling pipe inlets should be fitted with pipe bungs.
   

Always locate the sampling points in positions to which smoke may reasonably 

be expected to travel. Do not expect ceiling mounted sampling points to operate 

satisfactorily if air flow from air-conditioning systems keeps the cool smoke from an 

incipient fire reaching from reaching ceiling level. In this instance it is usually better 

to locate the sampling pipe directly in the airflow (for example across the return air 

register of an air conditioning unit).

There is no substitute for carrying out smoke tests prior to installation of pipe work to 

indicate suitable sampling point location.

No more than TWO Air Handling Units may be protected with one Stratos-Micra 

100 detector. In this application, ensure that the sampling pipe is raised clear of high 

velocity air in the immediate vincinity of the air intake grille on stand-off posts as shown 

below. 

Detector

Detector

Standoff posts

AHU

equipment
cabinet

Sampling pipe

Direction
of smoke

Incorrect

Correct
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5.2  
EN54-20 and

UL compliance 
 
 

 
 
 
5.2.1 EN54-20 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     5.2.2 UL

 The installation must be designed using PipeCAD software, which is provided free 
on the CD shipped with each detector. After designing the installation including 
pipes, endcaps and sampling holes, enter the detector type. To select the detector 
type, select Options, select Calculation options, and then select the detector from 
he Type drop-down list. 

 

 
 
 
 

t
 
Select “Options” “Calculate” or click on the calculator icon. The software will prompt 
you to choose from “Use set hole sizes” “Best flow balance” and “Max. permissible 
transit time”. Select the appropriate option and click “OK”. The results for each pipe 
(“View” “Results”) show calculations for each sampling hole on the pipe with the 
earest to the detector at the top of the screen, and the endcap hole at the bottom.  n

 
For EN54-20 compliance the transport time of the last sampling hole shall be 
checked following all installation and proven to be less than or equal to that 
etermined by PipeCAD.  d

 
The classification of each sampling device configuration and associated sensitivity 
settings are determined by the column headed “Hole sensitivity % obs/m” which 
shows the predicted sensitivity for each hole. For the installation to comply with 
EN54-20 depending on the class of installation, each sampling hole must be no 
ess sensitive than the following:  l

 
Class A: 0.62% obs/m 
Class B: 0.62% obs/m 

lass C: 0.62% obs/m  C
 
The calculation can be further refined by leaving a working detector in the 
protected area for at least 24hrs at the intended alarm factor for the installation 
(this could be done before or after installation). The detector sensitivity can be read 
from the “Sensitivity” figure on the histogram screen of the Remote software 
supplied with each detector. Click "Options" and then click "Calculation options" to 
open the "Hole calculation options" dialog box. Enter the sensitivity value obtained 
from the practical test, and then click OK. The new calculated value will use the the 
eal sensitivity from the practical test.  r

 
The PipeCAD software will determine the classification of any used configuration. 
Commissioning and periodic system tests must involve smoke tests to verify that 
the system performs as expected and enters Fire 1 alarm within the time 
determined by PipeCAD from the farthest hole. The detector sensitivity must also 
be inspected to ensure it has not radically fallen from the installed figure. If it has 
changed for any reason, the new figure must be re-entered into PipeCAD and the 
recalculated hole sensitivities must be confirmed to be within the class limits 
shown above. The settings of a compliant system should be recorded, as it is 
possible by changing certain programmable functions to make the system non-
compliant. If functions are changed, it is recommended that the system is retested 
if continuing compliance is in any doubt. 
 
UL268 fire tests were passed with an installation as follows: 
- Total sampling pipe length: 160 ft (single pipe) 
- Number of sampling holes: 10 
- Worst-case sampling hole sensitivity as indicated by PipeCAD: 1.28% obs/ft* 
- Alarm factor: 1 
- Fire 1 alarm delay: 0 seconds 
 
These settings gave satisfactory responses to the test fires in 120 seconds or 
better. For the purposes of UL268 compliance, these should be regarded as worst 
case values. Layouts should be planned in PipeCAD and the indicated worst-case 
hole sensitivity should be better than 1.28% obs/ft*. Commissioning smoke tests 
should be performed to ensure that the farthest sampling hole from the detector is 
capable of generating a fire alarm within 120s of receiving smoke. 
 
*The results should be verified at installation by entering the installed detector's Fire 1 
sensitivity (as indicated in the remote software histogram screen) into the PipeCAD 
“Options/Calculation options/Detector sensitivity” field and recalculating the layout results. 
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6.1 Docking station The basic principle behind installation of the Micra is that all wiring and pipe-work is 

installed using a docking station. This is a convenient feature which means that the 

detector can be dismounted or replaced without disturbing any wiring or installed 

pipe-work.

There are two types of docking station, one with a single inlet port for aspirating 

pipe-work, the other with a second port allowing the detector exhaust air to be taken 

back to the area of different atmospheric pressure from which the inlet is sampling (see 
section 4, “Sampling Pipe Design”, paragraph 1).  

Before installing the detector, the local standards for installation of aspirating detection 

systems must be consulted as these standards differ throughout the world. Specific 

advice for one country may not be applicable to another. The following is a brief set of 

guidelines on installing detectors.

■ 	 The detector will normally be mounted at a level where there is easy access to the 

unit for configuration and programming.

■ 	 The exhaust air from the unit must not be impeded in any way. If the unit is 

mounted in a different air pressure from where the air is being sampled (for example 

an air duct), then a pipe must be taken from the exhaust port back to the same air 

pressure zone as the sampling holes.

■ 	 All signal cables must be screened and must be of a suitable type. The specific type 

of cable will normally depend upon the local fire regulations.

■ 	 The unit must not be placed in areas where either the temperature or humidity is 

outside the specified operating range.

■ 	 The unit should not be placed in close proximity to any equipment expected to 

generate high Radio Frequency levels (such as radio alarms) or units generating high 

levels of electrical energy (such as large electric motors or generators).

6. Installation

ULC-S529-02 fire tests were passed with an installation as follows:

n 	 Total sampling pipe length: 302 ft (single pipe)

n 	 Number of sampling holes: 2

n 	 Worst-case sampling hole sensitivity as indicated by PipeCAD: 0.51% obs/ft

n 	 Alarm factor: 8

n 	 Fire 1 alarm delay: 7 seconds

These settings gave satisfactory responses to the test fires in 120 seconds or better. 
For the purposes of ULC529-2 compliance, these should be regarded as worst case 
values. Layouts should be planned in PipeCAD and the indicated worst-case hole is 
more sensitive than 0.51% obs/ft*. Commissioning smoke tests should be performed 
to ensure that the farthest sampling hole from the detector is capable of generating a 
fire alarm within 120s of receiving smoke.

*The results should be verified at installation by entering the installed detector's Fire 
1 sensitivity (as indicated in the remote software histogram screen) into the PipeCAD 
“Options/Calculation options/Detector sensitivity” field and recalculating the layout results.
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6.1.2  Mechanical installation

The docking station is connected to the installed sampling pipe-work and fixed to the 

wall or mounting surface using 3 off screws of a type appropriate to the mounting 

surface. Ensure that the sampling and/or exhaust pipes are securely seated in the pipe 

ports before fixing. If using a piped exhaust docking station be sure that the sampling 

and exhaust pipes are fitted into the relevant ports as shown in section 6.1.

6.2 Electrical installation

The Stratos-Micra 100 detector is supplied with removable terminal blocks (See illus-
trations in Section 2.2). These are simply removed from their sockets by lifting them 

up at right angles to the circuit board. Take note of the orientation of each terminal 

block and its function before removing it. It may also be beneficial to mark the connec-

tion wires with suitable identification labels or coloured rings to aid in the connection 

process. NB: All connections should be made with the power turned off.

6.2.1 Power supply connections

The power supply cable should be of screened type and should be led through the 

metal cable gland provided, leaving about 35mm of the cable extending from the bot-

tom of the cable gland. Depending on the type of cable used, it may be necessary to 

increase the diameter of the cable with sleeving or insulating tape to ensure that the 

cable is firmly held when the cable gland is fully tightened.

Remove the detector cover by unfastening the four screws 

at the front of the unit and detach the power supply ter-

minal block. This is on the small fan relay board located at 

the top left with the detector held with the serial port at the 

bottom of the unit. 

NB, note the orientation of the terminal block.

Connect 0V and +24VDC to the “0V” and “24V” screw 

terminals respectively. Connect the screen wire to the earth 

stud on the docking station and connect a second wire from 

the “Earth” terminal to the docking station earth stud. The 

picture in Section 5.1 shows the location of the earth stud. 

Fix the earth wires in place with the nuts provided.

Each detector is supplied with a pair of RF suppression 

ferrite rings. To ensure compliance with all relevant EMC 

requirements, the conductors of each cable should be 

wound once around a ferrite as shown here before enter-

ing the relevant connector. Power conductors should be on 

a separate ferrite, but different forms of signal conductor 

(e.g. RS485 and relays) can share the same ferrite.
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6.2.2	 Signal connections

RS485/SenseNET 
terminals

APIC address
terminals

To connect the signal wire, lead a suitable wire type (RS485 cable 9841, 120 ohm 

screened twisted pair or equivalent) through the second cable gland and tighten it into 

position with about 35mm of cable from the bottom of the cable gland.

Remove either the three-way terminal block next to the power supply socket if con-

necting the detector to a SenseNET system, or the four-way “Bus” terminal block if 

connecting the detector to an alarm panel in conjunction with the APIC addressable 

bus card (see section 7.3). For example, in a SenseNET system using screened cable, 

connect the screen wire(s) to the “SCN” terminal, Bus A wire(s) to the “A” terminal 

and Bus B wire(s) to the “B” terminal. 

If the detector is in the middle of a SenseNET chain, with input and output connec-

tions, it may be more convenient  to link the common Bus A, Bus B and screen wires 

to single A, B and screen wires for linking to the terminal block.
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6.3  Final installation
Once the power and signal connections are made, slide the detector body up into the 

docking station and fasten it into position using the M4 pan head screws provided. 

Slot the power and signal terminal blocks into the relevant sockets on the detector 

PCB (they will only click fully home in the correct orientation) and replace the detector 

cover using the four M3 pan head screws provided.

NB: The detector is designed solely for operation with the front cover securely 
fitted using all four fixing screws.

Removing the detector is simply the reverse of this process, leaving the pipe-work and 

wiring connections installed in the docking station.

Dock fixing 
screws

Cover fixing screws
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Because of the flexible nature of the Stratos-Micra 100 ® detector and the many possible 

configurations, there are many options for interfacing the detectors to the Fire Panel. 

These include many third party interfaces available from various manufacturers. 

Because of this, it is not possible to give a complete list of all interfacing methods but 

the following pages will give details of the most common methods that are likely to 

be used.

7.1 Setting the detector address

In order to identify itself to the PC Command Module or fire panel, each detector needs 

to have a unique address ranging from 1 to 127. The detector address is simply set 

on the DIP switch SW1 at the bottom left of the opened detector on the main circuit 

board. The switch settings are on for 1 and off for 0, and the detector address is set 

as a 7-bit binary code (switch 8 equates to a value of 128 and so is outside the usable 

address range). An example is shown below.

The address equates to 01100011 in binary, or (1 x 1) + (1 x 2) + (0 x 4) + (0 x 8) + (0 

x 16) + (1 x 32) + (1 x 64) + (0 x 128) = 99.

The full range of available addresses and their relevant switch settings are in section 

7.1.2 for reference.

7. Interfacing

1

DIL ON

2 3 4 5 6 7 8
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7.1.2  Address table

Addresses chosen for detectors do not have to be consecutive or in a given 

order so long as they are all different.

1 2 3 4 5 6 7 8
1 1 0 0 0 0 0 0 0
2 0 1 0 0 0 0 0 0
3 1 1 0 0 0 0 0 0
4 0 0 1 0 0 0 0 0
5 1 0 1 0 0 0 0 0
6 0 1 1 0 0 0 0 0
7 1 1 1 0 0 0 0 0
8 0 0 0 1 0 0 0 0
9 1 0 0 1 0 0 0 0
10 0 1 0 1 0 0 0 0
11 1 1 0 1 0 0 0 0
12 0 0 1 1 0 0 0 0
13 1 0 1 1 0 0 0 0
14 0 1 1 1 0 0 0 0
15 1 1 1 1 0 0 0 0
16 0 0 0 0 1 0 0 0
17 1 0 0 0 1 0 0 0
18 0 1 0 0 1 0 0 0
19 1 1 0 0 1 0 0 0
20 0 0 1 0 1 0 0 0
21 1 0 1 0 1 0 0 0
22 0 1 1 0 1 0 0 0
23 1 1 1 0 1 0 0 0
24 0 0 0 1 1 0 0 0
25 1 0 0 1 1 0 0 0
26 0 1 0 1 1 0 0 0
27 1 1 0 1 1 0 0 0
28 0 0 1 1 1 0 0 0
29 1 0 1 1 1 0 0 0
30 0 1 1 1 1 0 0 0
31 1 1 1 1 1 0 0 0
32 0 0 0 0 0 1 0 0
33 1 0 0 0 0 1 0 0
34 0 1 0 0 0 1 0 0
35 1 1 0 0 0 1 0 0
36 0 0 1 0 0 1 0 0
37 1 0 1 0 0 1 0 0
38 0 1 1 0 0 1 0 0
39 1 1 1 0 0 1 0 0
40 0 0 0 1 0 1 0 0
41 1 0 0 1 0 1 0 0
42 0 1 0 1 0 1 0 0
43 1 1 0 1 0 1 0 0
44 0 0 1 1 0 1 0 0
45 1 0 1 1 0 1 0 0
46 0 1 1 1 0 1 0 0
47 1 1 1 1 0 1 0 0
48 0 0 0 0 1 1 0 0
49 1 0 0 0 1 1 0 0
50 0 1 0 0 1 1 0 0
51 1 1 0 0 1 1 0 0
52 0 0 1 0 1 1 0 0
53 1 0 1 0 1 1 0 0
54 0 1 1 0 1 1 0 0
55 1 1 1 0 1 1 0 0
56 0 0 0 1 1 1 0 0
57 1 0 0 1 1 1 0 0
58 0 1 0 1 1 1 0 0
59 1 1 0 1 1 1 0 0
60 0 0 1 1 1 1 0 0
61 1 0 1 1 1 1 0 0
62 0 1 1 1 1 1 0 0
63 1 1 1 1 1 1 0 0
64 0 0 0 0 0 0 1 0

65 1 0 0 0 0 0 1 0
66 0 1 0 0 0 0 1 0
67 1 1 0 0 0 0 1 0
68 0 0 1 0 0 0 1 0
69 1 0 1 0 0 0 1 0
70 0 1 1 0 0 0 1 0
71 1 1 1 0 0 0 1 0
72 0 0 0 1 0 0 1 0
73 1 0 0 1 0 0 1 0
74 0 1 0 1 0 0 1 0
75 1 1 0 1 0 0 1 0
76 0 0 1 1 0 0 1 0
77 1 0 1 1 0 0 1 0
78 0 1 1 1 0 0 1 0
79 1 1 1 1 0 0 1 0
80 0 0 0 0 1 0 1 0
81 1 0 0 0 1 0 1 0
82 0 1 0 0 1 0 1 0
83 1 1 0 0 1 0 1 0
84 0 0 1 0 1 0 1 0
85 1 0 1 0 1 0 1 0
86 0 1 1 0 1 0 1 0
87 1 1 1 0 1 0 1 0
88 0 0 0 1 1 0 1 0
89 1 0 0 1 1 0 1 0
90 0 1 0 1 1 0 1 0
91 1 1 0 1 1 0 1 0
92 0 0 1 1 1 0 1 0
93 1 0 1 1 1 0 1 0
94 0 1 1 1 1 0 1 0
95 1 1 1 1 1 0 1 0
96 0 0 0 0 0 1 1 0
97 1 0 0 0 0 1 1 0
98 0 1 0 0 0 1 1 0
99 1 1 0 0 0 1 1 0
100 0 0 1 0 0 1 1 0
101 1 0 1 0 0 1 1 0
102 0 1 1 0 0 1 1 0
103 1 1 1 0 0 1 1 0
104 0 0 0 1 0 1 1 0
105 1 0 0 1 0 1 1 0
106 0 1 0 1 0 1 1 0
107 1 1 0 1 0 1 1 0
108 0 0 1 1 0 1 1 0
109 1 0 1 1 0 1 1 0
110 0 1 1 1 0 1 1 0
111 1 1 1 1 0 1 1 0
112 0 0 0 0 1 1 1 0
113 1 0 0 0 1 1 1 0
114 0 1 0 0 1 1 1 0
115 1 1 0 0 1 1 1 0
116 0 0 1 0 1 1 1 0
117 1 0 1 0 1 1 1 0
118 0 1 1 0 1 1 1 0
119 1 1 1 0 1 1 1 0
120 0 0 0 1 1 1 1 0
121 1 0 0 1 1 1 1 0
122 0 1 0 1 1 1 1 0
123 1 1 0 1 1 1 1 0
124 0 0 1 1 1 1 1 0
125 1 0 1 1 1 1 1 0
126 0 1 1 1 1 1 1 0
127 1 1 1 1 1 1 1 0

ADDRESS
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7.2 Connecting a Stratos-Micra 100 to a SenseNET/RS485 detector 
network

Up to 127 detectors may be linked in a single SenseNET bus, supporting a total length 

of wire between adjacent detectors of up to 1.2km.

In the above example, two Stratos-Micra 100 detectors are linked into a 127-detector 

bus with a Command Module and a number of Stratos-HSSD 2 detectors. It will be 

noted that whereas the Stratos-HSSD 2 units have two input / output buses (1A / 1B 

and 2A / 2B), the Stratos-Micra 100 has only a single such bus (A / B) and therefore 

each bus terminal has an input and an output wire, compared with a single wire in 

each terminal in the Stratos-HSSD 2.

For this reason, it may be easier to join the input and output wires for each bus and 

screen connections together and to solder or crimp a single wire or connecting ferrule 

to each wire pair so that they are easier to fit into the screw terminals. If this is done it 

is recommended that bare wire joints be insulated to prevent possible shorting of the 

data bus, which will cause a drop-out of data on the SenseNET bus.

In the above example, there could be a total length of RS485 cable of up to 1.2km 

between the Command Module and Detector 3, since these are all on a single bus. 

However, Detector 3 is a Stratos-HSSD 2 which has a second communications bus 

(RS485 bus 2) and an RS485 repeater. This allows a further total of 1.2km of cable until 

the next Stratos-HSSD 2 in the RS485 loop.

In the above example, if detectors 4-126 (not shown) were all of the Stratos-Micra 100 

type then the total length of wiring between detectors 3 and 127 would be limited to 

1.2km. However, each additional Stratos-HSSD 2 detector wired up using both RS485 

buses would allow an additional 1.2km of cabling to be added to the RS485 loop.

RS485 1A

RS485 1B

SCRN

RS485 2A

RS485 2B

SCRN

A

B

SCN

A

B

SCN

Detector 1
(Stratos-Micra)

Command
Module

Detector 2
(Stratos-Micra)

Detector 3
(Stratos-HSSD)

Detector 127
(Stratos-HSSD)

RS485 1A

RS485 1B

SCREEN 1

RS485 2A

RS485 2B

SCREEN 2

RS485 1A

RS485 1B

SCREEN 1

RS485 2A

RS485 2B

SCREEN 2
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7.3  Connecting a Stratos-Micra 100 to an addressable Fire Panel

An Addressable Protocol Interface Card (APIC) may be used to decode detector infor-

mation and to relay this to a Fire Panel.

The APIC is fitted to the four mounting studs on the Stratos-Micra 100 PCB using the 

supplied screws as shown below:

The connections to the Fire Panel are made using the BUS L1 and H1 (bus 1 input and 

output) and the BUS L2 and H2 (bus 1 input and output) terminal connectors shown 

in Section 6.2.2.

The only settings that need to be made are on the APIC address DIP switches. The start 

loop address Is entered on SW1 and the end loop address on SW2. In the case of a 

single Stratos-Micra 100 the start and end addresses will be the same.

NB: The detector address on the SenseNET loop and the Fire Panel addressable protocol 

address are the same, i.e. no address translation is performed. Some protocols may not 

support all the available alarm levels and fault reporting is usually a general fault with no 

detailed fault information. Please consult the specific APIC protocol documentation for more 

information.

Mounting  
studs x 4

APIC Address 
switch x 2

APIC 
Interface 
connection
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7.4. Connecting 
to a PC

To connect a single stand-alone detector to a PC, connect the PC‘s serial port directly 

to the detector‘s 9-way RS232 port. Connections for this cable are shown below.

9 pin female ‘D‘
connector

2

3

5

7

8

3

2

5

8

7

9 pin female ‘D‘
connector

Serial port 
connection

to PC serial port
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8. Event Log An event is defined as

• 	 a change to any programmed function

• 	 a signal received from an external controller such as the remote software, APIC or 

SenseNET

• 	 a detector output level meeting or exceeding the Pre-Alarm, Aux, Fire 1 or Fire 2 

alarm thresholds 

• 	 a fault condition such as a flow or separator fault

• 	 start of day / night operation

• 	 demonstration mode start / stop

• 	 FastLearn start / stop

• 	 Power on or off 

The detector stores an internal log of the last 200 events, and this can either be viewed 

on a PC screen or downloaded to disk by use of the remote control software.

When the event log is full (200 events are stored) and a new event occurs, the oldest 

event in the log is deleted (First-In, First-Out).

To download the event log, connect a PC to the detector serial port and run the 

remote software. Either select the menu options “View ➔ Event log” or click on the 

event log  symbol as indicated below.

The following screen appears:
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This shows the time and date of each event stored in the log along with its general 

description. The buttons at the bottom of the screen allow control over the input and 

output of the log.

Open: 	 opens a previously saved event log. Event logs have the file extension 

“.evl”.

Save As: 	 saves the current event log as a .evl file with a user defined name.

Print: 	 prints the event log to a connected printer.

Filter: 	 clicking on this option brings up the following screen:

This allows the user to limit the information printed or viewed on the PC screen.  

For example the user might wish to concentrate on alarm events only. To do this,  

click on “None”, which unticks all boxes, and then on “Alarms”. To tick all the boxes, 

tick “All”.

Any or all of the event categories may be selected or deselected as desired.
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The following brief checklist allows quick setup of the detector. This procedure will be 

adequate for most standard installations.

1. 	 Before powering up the detector, visually check all cabling to ensure correct 

connection. If wire identification is not immediately clear (e.g. by use of different 

coloured wires or wire identification sleeves) an electrical check should be 

made. Any damage caused by mis-connection of the detector is not covered by 
warranty.

2. 	 Power up the unit and connect to a PC and set the address switches on the 

detector board (see section 7.1) and APIC board if applicable (see section 7.3).

3. 	 Verify that the time and date are correct (see section 3.1)

4. 	 Set an appropriate alarm factor for the protected environment. The detector will 

perform a FastLearn for the new alarm factor. (see section 3.7)

5. 	 Whilst the detector is still in FastLearn mode set the detector into demonstration 
mode (see section 3.10). NB: Aerosol-type synthetic smoke sources should not 
be used to test the response of the detector as these may leave acidic residues 
which could cause damage to the unit.

6. 	 Wait for the FastLearn to finish and the flashing OK LED indicator will finish and 

perform any necessary smoke tests, ensuring that the detector reacts appropriately, 

and let the smoke fully dissipate.

7. 	 Perform another FastLearn, this time not putting the detector into demonstration 

mode. The detector will generate no alarms during the 15 minute FastLearn 

period, and after this the detector will operate at a reduced sensitivity for 24 hours 

whilst ClassiFire acclimatises to the protected environment and sets up appropriate 

day and night sensitivity settings.

9.1 Commissioning 
checklist

IMPORTANT NOTE 

!

Before commissioning the detector the local standards of aspirating detection systems 

must be consulted. These standards differ widely throughout the world and specific 

advice for the market in one country may not be applicable to another.

Commissioning strategy will initially depend upon the environment in which the 

detector is installed. For instance, the test for a computer room (which should be a 

relatively clean environment) would be very different from, say, a flour mill, which 

would probably have a high level of airborne particulate content.

A widely accepted standard for computer rooms/EDP areas is British Standard BS6266, 

equipment overheating at a stage well before combustion. To perform the test 

electrically overload a 1‑metre length of PVC insulated wire of 10/0.1mm gauge for 

one minute using an appropriate power supply. The detector has two minutes from the 

end of the wire burn to give an alarm indication.

For areas with higher levels of background particulate matter testing methodology 

would be similar to that of standard point detectors.

9. Commissioning
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10. Maintenance Stratos-Micra is a very low maintenance detection system. If required, external cleaning 

of the unit should be performed using a damp (not wet) cloth. Do not use solvents as 

these may mar the front panel label. The only part that may require field replacement 

during servicing is the dust separator assembly*. The dust separator condition can be 

checked using the Dust Separator test in the Miscellaneous tab of the remote 

software ‘Detector settings’ screen (see section 3.33) which gives a percentage 

reading of dust separator efficiency. When this level drops to 80% the detector will 

signal a fault and the dust separator will need replacing. To replace the filter, simply 

remove the front cover and pull the filter out from the main unit. Slide the replacement 

filter in so that the ‘Direction of flow’ arrow printed on the carton duplicates that on 

the ‘Direction of flow’ label beside the filter slot.

*It is recommended that dust separators be changed at an interval of not more than 
3 years. After replacing the filter, the detector must be put into FastLearn mode (see 
section 3.7) to reset the filter condition reading.

As dust contained in the dust separators may expose maintenance personnel to a 
‘Nuisance Dust‘ hazard as defined by the ‘Control of Substances Hazardous to Health‘ 
(COSHH), it is strongly recommended that suitable masks and protective clothing be 
worn when changing filters. Used separators are not intended for re-use and should be 
disposed of.

IMPORTANT NOTE 

!
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10.1 Diagnostics

The remote control software includes a diagnostic function which carries out a number 

of checks to verify the correct functioning of the detector. A good time to run these 

tests is as a part of planned maintenance. To call up diagnostic mode, select the menu 

options “View ➔ Diagnostics” or click on the symbol indicated below.

The following message  will then appear on the screen:

The software will then scan the loop for up to 127 detectors. For a single detector, wait 

until the first detector has been identified and the window indicates that it is scanning 

for Detector 2, then press the Cancel button.

The following window appears:

Click on the list entry to highlight it and click on the “Diagnostics…” button. The 

software will then commence the system tests. During the “Aspirator and flow” test, 

the detector fan will suddenly slow down, but this is a normal part of the test and no 

cause for alarm.
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When the test has finished and no problems have been found, the following screen 

appears:

If any problems were found during the diagnostic tests, the nature of the fault will be 

indicated in the “Status” column.

Scan: 	 Reads in the status of all connected detectors.

Read Button: 	 This brings up a display of the detector output and flow rate which 

updates in real time.

Relays: 	 Brings up a screen allowing the function of the volt-free ‘Fire’ and 

Fault LEDs to be tested with the aid of a continuity meter or other 

tester. The Fire relay contacts are open in normal operation and will 

close on test. The Fault relay contacts operate on a ‘Fail-safe’ basis 

and are held closed in normal operation. They will therefore open on 

test.

Save As: 	 Saves the summary list of scanned detectors and their status as a text 

(.txt) file.

Print: 	 Prints the summary list to a connected printer.
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11. Troubleshooting 11.1 Nuisance alarms occur too often

• 	 Check that the ClassiFire alarm factor setting is appropriate for the normal working 

environment of the protected area. See section 3.5

• 	 Check that the detector is not in Demonstration mode. This can be ascer-

tained by viewing the event log (see section 3) and checking that the entry 

Demo mode has a higher log entry number than the most recent 

FastLearn start and FastLearn end entries. Remember that the log 
entries are in reverse order, with the most recent entries appearing first. 

	 If the log shows that Demonstration mode was invoked during the last FastLearn 

period, start a new FastLearn and allow it to complete its 24-hour cycle. (See 
section 3.7) 

• 	 From the event log (see sections 8), check that 24 hours have elapsed since the 

last FastLearn end entry.

• 	 Check that day-night switchover times are appropriately set to reflect active and 

non-active periods (see section 3.11). 

11.3 Elevated smoke levels do not generate alarms

• 	 Check that detector is not Isolated or in FastLearn (if Isolated, the Fault light will 

be lit)

• 	 Check that the detector sampling points are in the smoke stream

• 	 Check that the correct ClassiFire alarm setting has been set (see section 3.5)

• 	 Check that the detector has either had a 24 hour learning period or that it has 

been placed in demonstration mode.

11.4  Low mean output

• 	 Check that the filter does not require changing (see section 3.35) and that the air 

plenum chamber is clean. The chamber may become clogged when, for example, 

heavy building activity has occurred near the sampling pipes. If so, the chamber 

may require factory service. The detector is not designed to handle large quanti-

ties of coarse debris and dust.

11.5 Detector sensitivity varies over time

• 	 There are many reasons why particle densities may vary, and the ClassiFire system 

automatically compensates for this in order to replace the likelihood of nuisance 

alarms due to normal variations in background smoke density. Within limits set by 

the ClassiFire alarm factor, this is a normal part of the detector‘s working.
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11.6 Flow fault errors

• 	 These occur when the airflow rate into the detector is outside the pre-programmed 

limits. As the detector ‘learns‘ the flow setup from the initial installation, this 

usually means that there has been some change in conditions. A Flow high fault 

may indicate that a sampling pipe is damaged, and a Flow low fault may indicate 

that the pipe has been blocked, e.g. by nearby building operations.

• 	 If the detector input is sampled from one area and the exhaust is in another area 

with different pressure (e.g. the detector is in a roof space and sampling from an 

enclosed room), this may lead to flow faults. In this case it would be necessary to 

lead a pipe from the exhaust to the protected area to ensure normal flow. This will 

require the detector to be installed using the piped exhaust docking station (see 
section 6.1).

• 	 Intermittent flow faults may indicate local short-term fluctuations in air pressure. 

To overcome this problem, the flow fault delay is programmable from 30 to 240 

seconds.

11.6.1 "Low flow" error messages.

• 	 Check that the pipe giving the error is not blocked

• 	 Check that the low flow fault threshold is not set too high (see section 3.29)

• 	 In the case of intermittent fault indications, try increasing the flow fault delay time 

(see section 3.32).

 
11.6.2 "High flow" error messages

• 	 Check that the pipe is pushed home into the inlet and is not broken or cracked

• 	 Check that installed pipe-work is fitted with an end-cap. 

PipeCAD® pipe modeling software prompts the use of appropriate end-caps. 

Open bore pipes are not recommended.

• 	 Check that the high flow fault threshold is not set too low (see section 3.30)

• 	 In the case of intermittent fault indications, try increasing the flow fault delay time 

(see section 3.32).
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12. Do’s and Don’ts 	 DO

✔ 	 Ensure that the ClassiFire alarm factor is appropriately set.

✔ 	 Ensure that cables are correctly connected before powering up by use of cable 

identifiers or electrical continuity checks. Incorrect connection could damage the 

detector.

✔ 	 Ensure that cable of an appropriate approved type is used for interconnection.

✔ 	 Place sampling points so that the detector will be able to detect smoke at the 

earliest opportunity.

✔ 	 Ensure that the detector exhaust is in an area with the same atmospheric pressure 

as the sampling pipes, either by placing the detector physically in the protected 

area or by leading a pipe from the detector exhaust to the protected area. 

✔ 	 Ensure that the environment of the protected area is within the environmental 

operating parameters of the detector (temperature -10 to +60°C, (humidity 0-
90%, non-condensing).

	 DON’T

✘ 	 Forget to set the appropriate ClassiFire alarm factor for the area to be detected.

✘ 	 Forget to set the Detector Address Switches correctly when used in a network.

✘ 	 Site detectors in damp or exposed areas.

✘ 	 Remove or connect boards when the detector is powered up.

✘ 	 Connect internal 0 volt terminals to local earth.

✘ 	 Attempt to re-use dust separator cartridges once removed.

✘ 	 Attempt to adjust or alter detector settings other than via the user-programmable 

functions. In particular, the setting up of the laser is a precision task, and once 

set up the potentiometers should be left alone. If it is suspected that the laser 

alignment has shifted (e.g. after dropping the detector), it should be returned to 

the manufacturer for recalibration.

 ✘ 	 Place the detector near high power RF sources.

 ✘ 	 Operate the detector with the front cover removed, or with one or more of the 

cover fixing screws loose or missing.

 ✘ 	 Test the response of the detector using aerosol synthetic smoke.
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13. Stratos-Micra 100 
specification

SELV rating (EN 60950)	 Class III

Supply Voltage	 21.6V - 26.4V DC 			 
	 PSU Type: conforming to EN 54-4 
	 Electrical safety complies with BS EN 	
	 610190-1

Size (mm)	 300W x 220H x 90D

Weight	 3.8kg with docking station

Operating temperature range	 0 to +38°C (UL268) 
	 –10 to +60°C (EN 54-20)

Operating humidity range	 0 - 90% Non Condensing 
	 BS EN 61010-1 Pollution degree 1 
	 BS EN 61010-1 Installation Cat. II

Sensitivity range (%Obs/m)	 Min = 25%  Max = 0.03% FSD

Maximum sensitivity resolution	 0.0015 % obs/m

Detection principle	 Laser light scattering mass detection

Particle sensitivity range	 0.0003µm to 10µm

Current consumption	 400mA

Relay contact rating	 500mA @ 30V

Maximum sampling pipe length	 100 metres total (see design limitations 	
	 on section 5)

Sampling pipe inlets	 2

Sampling pipe internal diameter	 15-25mm

Alarm levels	 4 (Fire 2, Fire 1, Pre-Alarm and Aux) 
	 1 relay as standard, others available

Chamber service intervals	 Greater than 8 years (depending on 	
	 environment)

Dust separator replacement intervals	 Greater than 5 years (depending on 	
	 environment)

Laser lifetime (MTTF)	 Greater than 1000 years

Programming	 PC via RS232/RS485

Data bus cable	 RS485 data cable

Data bus length	 1.2 km

IP rating	 IP50

This equipment is only to be used in accordance with this specification. Failure to 
operate the equipment as specified may cause damage to the unit.

NB ☞
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